
GEOG357, Lab 6: Glacier mapping / extraction  
 

1. Introduction 

 

This lab uses the Landsat 9 Operational Land Imager (OLI-2): 9 Sept 2023 image (path 

46, Row 23) of the ‘Resthaven Icefield’ (rh) from the Willmore Wilderness, AB, located 

between Kakwa Provincial Park, BC (to the north) and Mt. Robson Park, BC  / Jasper 

national Park to the south. 

 

The file contains bands 1-7 plus band 10 thermal infrared = 8 channels 

The PAN (chromatic) band 8 remains as a separate pix file because if we included it in 

the multispectral file, it would lose its higher resolution (15m). 

 

In windows explorer, copy to your own folder, these files from L:/geog357/labs2025 

rh2023.pix 

rh2023pan.pix 

 

This is a good late summer image with little remnant snow outside the glaciers – which 

would look the same spectrally as snow on glaciers, but the shadows are heavier than 

they would be in July/August. Remember to edit new layer names as you create them. 

 

2. Data display 
 

Open the two files, with the multispectral file on top / visible : 

rh2023.pix – change display to 432 in RGB and zoom in on some glacier areas – can you 

see glaciers in the shadow areas ? 

now change display to the 654 composite (enhance) – the shadows are darker in infrared. 

 

Load the thermal band:  layer-add-grayscale- select band 10 (in channel 8) 

click the thermal display on/off between the 654 composite and thermal file to see how 

they relate to each other. The thermal is lower spatial resolution. (100m) but picks out the 

ice and shadows (cooler) versus the two ‘recent’ fire areas (2007/2015) as ‘warmer’ – due 

to the removed vegetation, not from remnant heat from the fires (=’drier’ in SWIR band). 

The two fires are towards the NW (2007) and NE (2015) – we’ll view them in Lab 7. 

 

Examine the histogram for the thermal layer  (right-click on filename -> histograms). 

Note that the range of values are lower than for the reflective bands (1-7 / Pan) 

 

Q1a. What are the minimum and maximum DN values ? 

1b. Why is the range of DNs smaller for the thermal band than the reflective bands ? 



 

click the thermal layer off 

 

Compare the 654 and Pan displays in the glacier areas 

– zoom in to see the higher resolution (15m) - look for glaciers/snow in the shadows and 

compare with the RGB display. 

 

3. Glacier extent extraction 

 

a. Unsupervised classification 

 

Run a quick Isodata classification (analysis->Image classification) – input bands 4,5, 6 

and use the default values – 16 classes; you will need to add a new empty 16 bit 

(unsigned) layer to hold the classification output. 

 

You will find it clusters shadows and does not isolate glaciers into simple clusters. Could 

you group several clusters to extract glaciers – maybe not exactly. They should be several 

consecutive cluster (class) numbers. Right-click on the classification channel in the TOC 

and -> representation editor to show the cluster number colours. 

 

Q2a. How many clusters cover ice/snow – and which ones (cluster numbers) ?  

Q2b. Why are there several just for snow/ice when there are so many other cover types? 

(this was noted in the lecture on glaciers) 

 

b. NDSI (Normalised Difference Snow Index) 

 
Use the raster calculator (RC) to create NDSI: (Green – SWIR) / (Green + SWIR) 

remember to double-click on selected bands / single click on operators  

Output to 32-bit layer (display) .. and save to your Resthaven (rh) file 

 

Glaciers have the highest DN values for clean snow and ice, but can’t always isolate 

these three problematic features: shadows, meltwater lakes and debris-cover. What seems 

to be a good lower threshold value for snow / ice ?  (and excluding most water).  

 

View the histogram for NDSI and see what DN might separate the main (land) data peaks 

and snow/ice. Run THR with your best guess (minimum) threshold value 

 

Q3a. what is your chosen NDSI  threshold value for snow/ice ?  - note it down to go with 

the corresponding DN value for the Red/SWIR in the section below. 

 



 

c. Create a Red/SWIR ratio  

 

Use the Raster Calculator to create the Red/SWIR ratio  (4/6) 

Tools-> Raster calculator .... you know how to do a ratio -  make it so.      Run. 

Output to a 32-bit layer, first output to display and if it looks OK, run again and save to 

your multispectral .pix file (ALWAYS!) 

 

Edit the description for the new layer/channel to: something like Red/SWIR ratio 

Review the histogram for the new channel – a suitable threshold value should be 

somewhere in the dip between the two peaks (land and snow/ice). 

 

4. Thresholding for snow and ice 

 

Click around the ice surfaces to see possible threshold values, especially the darker ice 

near the snouts. To compare with the 654 display, highlight the ratio channel, but check it 

off, and view the 654 RGB; click around to review ratio values on the darker ice areas.  

For TM data, we normally use 2.0 as a threshold to identify snow and ice, but here with 

OLI data, 2.0 captures most ice and snow but not all the darker ice near the snouts. 

It could be more like 1-7 or 1.8 – otherwise we lose some glacier snouts. 

 

The exact value is always a toss-up between getting all the ice but including some non-

ice. Make your own judgement - there may not be a perfect value, and there's always 

possible sieving and editing afterwards. 

 

We use THR to create an ice bitmap, as in labs before (THR:  PLEASE work today !) 

 

Q3a. what is your threshold ratio value for snow/ice ? – also note here your NDSI value 

3b. Explain why the NDSI (index) and 4/6 ratio images are so similar in appearnce 

 

THR 

We want all pixels with high DN in ratio channel DN e.g.  > ~1.75 to display (bitmap) 

Input  = the ratio channel  

Parameters:  minimum threshold = choose your value (maybe 1.7-1.8 ?) 

no value needed for maximum 

Run 

 

Check display - too much, too little or good enough ? 

- Compare with 654 composite by clicking bitmap on and off 

Try different values and settle on your best option 

Then run THR again and save to your rh2023.pix file  (NEVER untitled.pix) 



 

We could then run BIT2POLY as we did in earlier labs, to create glacier vectors. 

But, there are two issues with the bitmap approach: 

a.  There are isolated pixels, and small groups – and you can’t sieve a bitmap 

 

b. The threshold fails to find glaciers in shadow as the ratio DN is lower, but does find 

(silty) water which has higher DNs. Flip between the 654 composite and pan image to 

better see the glaciers in shadows; in comparison, they are hard to see in the IR.  

See also where the threshold has included silty lakes. e.g. 329000E, 5925000N 

 

For this lab we’ll finesse the threshold for silty lakes, but leave the shadows for now ... 

 

 

5. EASI MODELLING SCRIPT 
 

We can help solve the silty lakes by adding a condition using the near-IR band – as ice 

reflects NIR more than silty water. Query the 654 composite on ice and in silty lakes to 

see the NIR values (displayed in the G gun). the value separating them could be ~8000 ? 

Check for yourself if this value works  

 

Meltwater lakes – we use a condition where ratio > 1.x  (your threshold)   AND   NIR > 

8000, then we will write to a new empty channel and set this condition as below: 

 

Set-up 

 

Create a new empty 16-bit (unsigned) channel to contain the result (unless you already 

have an empty one:  

Switch to the files tab, and right-click on rh2023.pix 

New - raster layer – 16 bit unsigned - add 

 

This should create a new raster ‘contents not specified’ in the listing on the left 

- It could be layer 12 (?) (8 band channels, + unsupervised + NDSI + ratio + new ) 

Check your rasters if unsure 

This will be %Y below  .. don’t type  Y !!!   

 

What is the channel number for your ratio  (e.g. 11?) – this is  %X  below – don’t type  X  

Why do I emphasise this – because every year someone types X and Y however many 

times I say “don’t” … X and Y are only ‘placeholders in case your file layers differ. 

 

First load the new empty channel: 

Layer-> add -> pseudocolor -> your empty channel (12?) 

Nothing will appear (yet) as its empty 

 

Tools-> EASI Modelling 



To extract glaciers and deal with silty water, enter this script: 

 

If   %X  > 1.? (enter your value) and %5 > 8000 then 

%Y = 1 

Endif 

 

Where X = your ratio channel and Y = your empty channel 

DON’T TYPE X and Y  (did I already say that?) – and do insert your threshold value  1.? 

You must include ‘then’ on the end of line 1 (as above) 

Run 

 

Can you see the logic ?  %X = the channel number, just like in raster calculator 

Why do we use 1 in %Y :   1 = ice, 0 (blank) = not ice  

 

Save your script file – it will assume a   .eas suffix (short for easi modelling)     

e.g. glaciers-nolakes.eas 

 

Note: if somehow you mess up the new channel layer, you can refresh it by typing a 

simply script:   %Y = 0   run    (Y= 12?) ..  DON’T type ‘Y’ !! 

This simply ‘cleans the slate’ and makes the channel empty again 

If you did this to one of your bands, you would wipe out that layer, so check you have the 

right channel first – it should NOT be one of 1-11  

 

Check your new channel that should contain ice/snow – it should have appeared on 

screen, almost the same as the previous bitmap from the ratio, but with silty lakes 

removed – click the bitmap on and off to see the difference.  

If the new layer ice appears as black or a barely visible colour, right-click on that layer 

and change it using the Representation Editor 

 

It should also have many small areas due to the nature of pixelation plus there are small 

remnant snow pockets, and we only want the ‘real’ glaciers which exceed a given size. 

Check the layer by clicking on and off with the 654 (30m) composite – and then for 

shadow areas view the 432 (30m) composite and/or the Pan band image (15m).  

We accept we lost some (we may modify the script in Lab 8 to add shadowed glaciers) 

 

Debris covered ice: we can't do much about this in Labs – it’s an advanced research topic. 

e.g. there's debris-covered ice ~ 340000E, 5922500N  

 

6. SIEVE 



There are too many small snow/ice patches and for glacier inventory, we would not go 

below 1 hectare (11 adjacent pixels) and often 5 hectares (55 pixels) 

Input your glacier raster (12?) 

Output to viewer-PCT 

Parameters: Polygon size threshold – enter 11 

Connectedness: either 4 or 8 

Got to log tab and Run 

 

Assuming it worked (?) … 

In glacier mapping, we often use 5 hectares as a minimum = 55 pixels 

Set your threshold minimum now to 55  

run .. and if the result is good, run again with output to your rh2023.pix file 

be sure to edit layer names as you go (Files Tab – click on layer name to edit) 

 

7. Conversion to vector:  RAS2POLY (we might also have used EXPOLRAS)  

 

Input file will be your new channel containing sieved glaciers (13 ?) 

Output first to Viewer and if successful, then run again to your rh2023.pix file 

Input Parameters: ensure ‘Smooth vectors’ box is ticked 

Switch to log tab and Run 

View result - You can change the vector colour if need be: right-click ->  color 

 

8. Vector attribute table 
 

Right-click on polygon layer, select Attribute Manager 

From the attribute manager: right-Click on Area heading 

Turn OFF Scientific Notation and change units to hectares    … OK 

Click in Column 1, first row (above yellow space) – total glacier area is displayed at the 

very bottom (in hectares) 

 

Q4a. What is the sum total area (km2) of glaciers in 2023 ? 

4b. What is the area of the Resthaven Icefield – the largest glacier polygon 

 

You could also save as a shapefile: so you can open it in GIS software 

Right-click on the vector label in maps tab-> Save as -> Arcview Shapefile           

e.g. rh-glaciers2023.shp 

 

Easy Google questions to finish off: 

Q5a. what is band 9 on Landsat 9 OLI-2 (missing in this dataset) – what would it show? 

5b. why did I choose to only retain Thermal band 10, rather than band 11 ? 

 



As usual, please submit your answers as .TXT or .PDF via Moodle 

 

Process for taking advantage of the higher resolution Pan image below: good 

if you choose glaciers for a project but a bit too much in today’s lab: 

 

 

9. Using the higher resolution PAN band (optional) !! 
 

As described in lecture, some like to use the Pan band on Landsat 8/9 instead of the Red 

band to create the ratio layer and subsequent vectors with 15m resolution. 

 

First you will need to add the NIR (5) and SWIR band (6) TO the pan file (not vice versa) 

 

File-> Utilities-> Transfer layers… 

In the pop-up window, source file = rh2023.pix 

Destination file:  rh2023pan.pix 

Highlight bands 5 and 6, then click add ,  then ‘transfer layers’  and close 

Display your transferred SWIR layer in the pan file to check it worked:  

Layer-add-grayscale .. and pick the SWIR layer in the PAN file  

The SWIR band now has the same resolution as the PAN band, but looks blockier as you 

can’t just add detail by duplicating pixels, … this will happen with the new ratio: 

 

Repeat steps 3c->7  

… but using the PAN band instead of Red, and rh2023pan .pix file instead of rh2023.pix 

 

3c: Pan / SWIR ratio – using the rh2023pan.pix  file  (it will become channel 4) 

4. Thresholding the ratio – examine the best DN threshold – likely to differ from before 

5. EASI modelling to exclude silty water – using the pan file (it will become channel 5) 

6. Conversion to vector – again all in the pan file 

7. Vector attributes – revised glacier area using the higher resolution 

 

.* your ratio and threshold values in channel 4 may/will be different to before with 

Red/SWIR, you will need to find this new value to create the best glacier outlines 

However the NIR value (8000?) will stay the same. [we had to include the NIR band in 

the transfer so you can include the silty water factor in step 5]. 


